Effective Budgeting and Financial Management

By Rachel Strohm

COO, Mawazo Institute

March 2018
1. Overview

Even though academics often don’t get formal training in budgeting and financial management, these practices are essential parts of making sure that your research goes well! This training will focus on using Excel to create budgets that capture all your project activities, have clearly documented cost estimates, and can be used to track expenditures as well as projecting costs. During the training session, I will demonstrate some of Excel’s useful features, and we will take time for everyone to work on updating their budgets.

There are three major principles of budgeting which I’ll return to throughout this document:

- Explain your cost assumptions and calculations clearly
- Provide lots of detail
- Let Excel do the work for you

There are also three major principles of financial management which having a good budget will help you to achieve:

- Plan ahead for your expenses
- Keep track of all your expenses, including getting receipts for every purchase
- Compare your projected costs to your actual expenses

In this training, we’ll be working with the spreadsheet labelled “Mawazo Sample Budget 2018.” It’s based on a research project that I planned to carry out (but didn’t actually start) in early 2016 in Ghana. My research question was about whether people who received new welfare benefits from the government were more likely to vote or participate in local politics. The research design involved comparing welfare recipients to similar people who hadn’t received any welfare benefits, and carrying out a quantitative survey of these people in four regions across Ghana. It is a fairly complex budget, so don’t feel compelled to go through it in detail. I’ll draw out some relevant examples from it during the budget training.

There are three deliverables that each Scholar must produce after the training. More information about each will be provided during the training.

- A project timeline, which captures all of the activities involved in completing their current research, and shows when they will need money disbursed
- An updated budget, complete with well-documented assumptions and an expense tracking sheet
- A budget narrative which explains all the activities and the estimated costs for each

2. Making the Most of Excel
Before we begin talking about the budgeting process, let’s talk about Excel. Excel has a lot of useful features which most people don’t use, but which can really help to make a budget easier to understand and to update. Here are some of the techniques that I use most often.

2.1. Use Multiple Sheets to Keep Your Budget Organized

One useful feature of Excel is that you can create multiple sheets within the same document. In “Mawazo Sample Budget 2018,” look at the bottom of the Excel document, and you’ll see the sheets labelled “Timeline,” “Assumptions,” “Budget,” and “Expense Tracking.”

There are two major advantages to keeping all of the different sections of your budget, from the activity timeline to the expense tracking section, in the same document. First, it’s more organized to have separate sheets for the various components of the budget, rather than cramming them all into a single sheet. Second, you can link up cells between separate sheets. This means that if you change the value of a cell in one sheet, it will automatically be changed in all of the linked cells in every sheet, so you don’t have to manually update them. For example, if you had used separate Excel files for the assumptions and budget sheets then it wouldn’t be possible to do this.

2.2. Link Cells so You Only Have to Type Any Estimate Once

This is one of the most powerful budgeting tips. You can use Excel’s ability to link cells within and between sheets to link the values in your assumptions sheet to cells in the budget sheet, so that if you change an assumption, the budget itself will automatically be updated.

Here’s how to link cells between sheets. You can see how this works in the “Mawazo Sample Budget 2018.”

In the assumptions sheet, line 7 provides an estimate for the cost of an international flight from the US to Ghana (about US$ 1600). Now I’d like to link this cost to the same line item for the international flight in the budget, which is in the budget sheet at line 49. Here’s how to do this.

- Select the cell you’d like to fill in on the budget spreadsheet (in this case, the “Unit Cost” cell at D49)
- Type the = sign
- Click over to the assumptions sheet, and select cell C7 with the value of US$ 1600
- Press the Enter key
- Cell D49 in the budget sheet should now have the same value of US$ 1600 as cell C7 in the assumptions sheet

If I later found a great discount on flights, I could then change cell C7 in the assumption sheet to US$ 1000, and the linked cell D49 in the budget sheet would automatically be updated. No need to remember to copy and paste!
2.3. Use Color to Distinguish Sections and Calculations

There are three ways to use color to help you navigate the budget. First, most budgets will have different activity categories, many of which might also have subcategories. You can put your headings in different colors to distinguish between categories and subcategories.

In Figure 1 from the budget sheet in “Mawazo Sample Budget 2018,” each overarching category is listed in blue, and the subcategories within it are listed in grey. (Notice that the category is for personnel costs, and the subcategories are for personnel at different points in the research process, like hiring surveyors, and doing initial visits to the towns I planned to survey.)

Fig. 1: Using Color in the Budget

<table>
<thead>
<tr>
<th>6 Budget Category</th>
<th>Unit Description</th>
<th>Number of Units</th>
<th>Unit Cost</th>
<th>Currency</th>
<th>Total Cost (Original Currency)</th>
<th>Total Cost (USD)</th>
</tr>
</thead>
<tbody>
<tr>
<td>7 Personnel</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>30850</td>
</tr>
<tr>
<td>8 Hiring + Training</td>
<td>Per diems for training</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>4950</td>
</tr>
<tr>
<td>9 attendees</td>
<td>Compensation for their time</td>
<td>300</td>
<td>50 GH¢</td>
<td></td>
<td>15000</td>
<td>3750</td>
</tr>
<tr>
<td>10 Catering for lunch</td>
<td>From a local restaurant</td>
<td>12</td>
<td>400 GH¢</td>
<td></td>
<td>4800</td>
<td>1200</td>
</tr>
<tr>
<td>11 Community Entry</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>1875</td>
</tr>
<tr>
<td>12 Team leader daily wage</td>
<td></td>
<td>60</td>
<td>100 GH¢</td>
<td></td>
<td>6000</td>
<td>1500</td>
</tr>
<tr>
<td>13 Team leader per diem</td>
<td>For lunch + transport</td>
<td>60</td>
<td>25 GH¢</td>
<td></td>
<td>1500</td>
<td>375</td>
</tr>
</tbody>
</table>

Second, I find it very useful to use color to keep track of how I need to interact with different cells. One thing that is often useful to note when creating a budget is whether the value in a given cell needs to be input manually, or whether it’s linked to another cell and will be updated automatically. If I then need to return to this budget months or years later, to update it or use it as the template for another project, I can then easily figure out which cells I have to update by hand.

In the budget sheet pictured in figure 1, the cells in yellow are linked to cells in the assumptions sheet. This reminds me that I don’t need to put these values in by hand – they’ll automatically update based on the value of the linked cell in assumptions. The cells in blue are calculated within the spreadsheet (i.e. total cost = number of units * unit cost). This similarly reminds me that I shouldn’t be doing these calculations by hand – it’s much better to let Excel do them for me! Finally, while it’s not pictured here, if I have to put in a value by hand, I’ll highlight the cell in green.

Third, I can use color to keep track of how whether I’m capturing the same project activities in different sheets in the document. As the section on budgeting below discusses, it’s important to write your timeline and list all of your cost assumptions before you start writing the budget itself. As I’m writing the budget, I find it useful to check back to the assumptions sheet to make sure that I’ve included all the activities there, and highlight them in orange once I have included them, so I can more easily keep track of this.
2.4. Use the SUM Command to Add Up Column Totals

If you’re already using Excel commands like SUM, that’s great! If not, this is a useful tool that will save you a lot of time spent adding up individual cells.

SUM is a command to add up all the cells selected by the user. It’s great for calculating the total value of budget categories. Here’s an example from the budget sheet in “Mawazo Sample Budget 2018.” This is the “equipment” category, which has subcategories for “background interviews,” “hiring and training,” “community entry,” and “survey.” In my budget, I want to see how much each of those subcategories costs, as well as the total cost for the equipment category overall.

**Fig. 2: Summing Columns**

<table>
<thead>
<tr>
<th>6</th>
<th>Budget Category</th>
<th>Number of Units</th>
<th>Unit Cost</th>
<th>Currency</th>
<th>Total Cost (Original Currency)</th>
<th>Total Cost (USD)</th>
</tr>
</thead>
<tbody>
<tr>
<td>27</td>
<td>Equipment</td>
<td></td>
<td></td>
<td></td>
<td>8820</td>
<td></td>
</tr>
<tr>
<td>28</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>210</td>
<td></td>
</tr>
<tr>
<td>29</td>
<td>Background Interviews</td>
<td>40</td>
<td>1</td>
<td>GH₵</td>
<td>40</td>
<td>100</td>
</tr>
<tr>
<td>30</td>
<td>Printing</td>
<td>40</td>
<td>5 USD</td>
<td></td>
<td>200</td>
<td>200</td>
</tr>
<tr>
<td>31</td>
<td><strong>Hiring + Training</strong></td>
<td></td>
<td></td>
<td></td>
<td>950</td>
<td></td>
</tr>
<tr>
<td>32</td>
<td>Newspaper advert for</td>
<td>4</td>
<td>400 GH₵</td>
<td></td>
<td>1600</td>
<td>400</td>
</tr>
<tr>
<td>33</td>
<td>surveyors</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>34</td>
<td>Training facility rental</td>
<td>12</td>
<td>100 GH₵</td>
<td></td>
<td>1200</td>
<td>300</td>
</tr>
<tr>
<td>35</td>
<td>Community Entry</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>150</td>
</tr>
<tr>
<td>36</td>
<td>Chief gifts</td>
<td>120</td>
<td>4 GH₵</td>
<td></td>
<td>480</td>
<td>120</td>
</tr>
<tr>
<td>37</td>
<td>Printing</td>
<td>120</td>
<td>1 GH₵</td>
<td></td>
<td>120</td>
<td>30</td>
</tr>
<tr>
<td>38</td>
<td>Survey</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>7510</td>
</tr>
</tbody>
</table>

SUM can be used to add up data that’s in a single column. Here’s how I came up with the figure of $950 for the “hiring and training” subcategory.

- Select the cell where you want to have the summed value. In this case, it’s the cell G31 in the “total cost (USD)” column, in the line for “hiring + training.”
- In that cell, type `=sum(`
- You’ll see a little dialogue box pop up that asks you to select the numbers you want to sum up. Look at Figure 3 for an example.
- Click one of the cells in the column that you want to sum up, and then select all the other cells that should be included in the sum. You can do this by holding the Shift key while hitting the up or down arrow on your keyboard.
- Once you’ve selected all of the cells you want included, type `)`
- So, in this example, you would see `=sum(G32:G34)` displayed in cell G31.
- Hit the Enter key.
- Cell G31 will now display the sum of the other cells that you selected. In this case, 400 + 300 + 250 = 950.
Once you get used to using SUM, you’ll find that it’s a lot faster than manually typing in =400+300+250 to get the same result. It’s also better, because if you update any of those values in Excel, the summed value will also automatically be updated.

One important thing to note is that SUM can only be used to add up cells that are right next to each other. So, let’s say that you want to add up the subcategory totals in Figure 2 to come up with the total cost for the equipment category. SUM isn’t the right command for this, because the subcategory totals are on separate lines with other numbers in between.

In this case, it’s best to tell Excel to only add up the cells that have the subcategory totals in them. Here’s how to do this for the equipment category.

- Select the cell where you want the category total to be displayed. In this case, it would be cell G27 in the “total cost (USD)” column and the “equipment” row.
- Type =
- Click on cell G28, which has the total cost for the first subcategory you want to include, which is “background interviews.” The original cell (G27) should now display =G28
- Type +
- Click the next cell you want to include, which is G31, the total cost for the “hiring and training” subcategory. The original cell will now display =G28+G31
- Continue to add subcategory totals until you’ve included all the subcategories
- Hit the Enter key
- Cell G27 will now display the total cost for all the subcategories in the equipment category

If you add up the category totals this way, then they’ll automatically be updated every time a subcategory total changes. You can also use the
same process to **add up the category totals to come up with the total project cost.**

2.5. Freeze Panes to Keep your Category Headings Visible

Excel has an option to **keep certain columns and rows visible in a spreadsheet**, no matter how far you scroll. This is useful for a budget, because you can keep your column headings (like “activity,” “unit cost,” and “number of units”) visible no matter how many line items you add.

This option is called “freeze panes.” Here’s how to use it.

- Identify the columns and rows you always want to have visible. For example, let’s say you want column A and row 1 to always be visible.
- Select the cell in the next column over (B) and the next row down (2) – in this case, B2.
- In the ribbon at the top of the screen, go to Window > Freeze Panes.
- Now column A and row 1 should always be visible, no matter how far you scroll.
- If you want to undo this, go to Window > Unfreeze Panes.

You can see how this works in “Mawazo Sample Budget 2018.”

2.5. Group Your Data to Make a Large Budget Easier to Navigate

If you have dozens of different line items in your budget, it may get tedious to scroll through all of them as you navigate between sections. Excel’s “group data” feature makes it easy to **collapse and expand groups of rows**, so that you don’t have to scroll past them. If your budget is fairly small, you may not want to do this, but it’s a useful option to at least be aware of.

Here’s an example from the budget sheet in “Mawazo Sample Budget 2018.” Figure 4 shows the “travel” category in the budget. It shows the total cost for the category (line 48), as well as the individual line item expenses (lines 49 – 53). The group here is lines 49 – 53, and it’s expanded.

If you look at the far-left side of the sheet, past the row numbers, you’ll see a vertical line with a small box with a negative sign in it at the bottom. If you clicked the box, it would collapse the group.

**Fig. 4: Expanded Group**
Figure 5 shows what it looks like when the group is collapsed. Now you can’t see the grouped lines. Notice that line 48 is not part of the group, which is why it’s still visible. If you clicked on the box with the plus sign at left, it would expand the group again.

![Fig. 5: Collapsed Group](image)

Here’s how to group data.

- Select the rows you want to group. Remember that none of these rows will be visible once they’re grouped and the group is collapsed.
- At the ribbon at the top of the screen, go to Data > Group and Outline > Group. This will create the group.
- Click on the box at the bottom of the vertical line at the left side of the screen to collapse or expand the group.
- If you want to undo the group, select the same rows, then go to Data > Group and Outline > Ungroup.

### 3. Budgeting

The goal of a budget is to help you **accurately estimate the total cost of a research project** – and also help you remember why you came up with certain estimates when you look back at the budget a year later! There are four principles which will make a budget more accurate and easier to use.

- Create a timeline of all project activities, to make sure you haven’t forgotten to include anything in the budget
- Document all of the assumptions about your cost estimates and project timeline clearly
- Use Excel to create a budget spreadsheet which will automatically be updated whenever a cost or time estimate is changed, and which accounts for inflation and contingency costs
- Write a budget narrative which clearly summarizes all of the project activities and their associated costs. This will minimize confusion if you have to look back to the budget in a few months’ time, or use the same template for another project.
3.1. Project Timeline

The goal of the project timeline is twofold: to make sure you’ve included all the necessary activities, and to get a sense of how long each activity will take. The length of time required for an activity may have cost implications, for example if you need to rent equipment or pay surveyors for a specific period.

Because the timeline is so closely connected to the budget, it can be useful to create the timeline in the same Excel sheet that contains the budget. In this way, you can make sure that all of the planned project activities in the timeline are also captured in the budget’s “Category” column. You can also check that the time estimates in the timeline are reflected in your budget assumptions.

The first sheet in the “Mawazo Sample Budget 2018” spreadsheet is for the timeline. At the top of the sheet, there are spaces to list the research question and research design that feature in your project. This serves as a reminder to clearly articulate how each project activity is helping you answer your research question. In addition, if you have to submit the budget as a part of a grant application, it will help the funder more clearly understand how the activities are connected to the research question.

The rest of the timeline spreadsheet has six columns: “Research Activity,” “Activity Description,” “Time Needed,” “Time Value,” “Dates,” “Location,” and “Cost.”

The “Research Activity” column should list everything you would consider as a separate activity for your research. For example, at minimum your activities might be “data collection,” “data analysis,” and “writing article.” However, if you can be more specific than this, it will help to make your budget more accurate. Thus, “data collection” might be broken down into “background interviews,” “conducting survey in region A,” and “conducting survey in region B.” The “Activity Description” column should provide more detail on what you will accomplish with each activity.

There are two ways of estimating the time needed for an activity. For some activities, like writing a literature review, you may already have a sense of how long it will take. In that case, it makes sense to just directly input your estimate of the time into the spreadsheet. In the sample budget, I’ve highlighted these cells in green. However, for other activities, you may need to calculate how long they will take. For example, you may need to calculate how long it might take to interview 300 people in 30 towns. In this case, it’s best to put these figures into the assumptions sheet, and use that to calculate the total time (as will be discussed in the next section). The cells where I’ve done this are highlighted in yellow.
The columns for “Time Needed” and “Time Unit” are separated, because if you use the assumptions sheet to calculate the time, this will just produce a number and not the unit for the number. You’ll need to add that separately. (For example, it might produce the number “3,” and then you’ll need to add in the relevant unit of “months” or “weeks.”)

Once you have time estimates for each activity, you can put in specific dates for the activity in the “Dates” column. It’s also useful to list your location in the “Location” column, as a reminder not to forget about travel costs.

The final column in the timeline is “Cost,” where you list when you’re going to need to spend certain amounts of money. This is very useful for us at Mawazo because we’ll use this to guide your research grant disbursements. This is the very last step in completing the budget, since you’ll have to go through the whole budgeting process before you have these cost estimates. Once you’ve completed the budget, add up the total amount required for each of the activities on the timeline, and paste this into the “Cost” column. (Again, let Excel do the work here! You can add the figures from the budget spreadsheet by linking the cells, as discussed in the section above.)

3.2. Listing Assumptions

The purpose of having an “assumptions” sheet in the budget is for you to clearly document how you came up with the cost and time estimates that feature in the budget. It also makes it easier for you to link calculations between the assumptions and budget spreadsheets, so that if you need to later change a single assumption, all of the related calculations in the budget will automatically be updated.

The assumptions sheet has six columns: “Activity Category,” “Unit Description,” “Value,” “Currency,” “Unit,” and “Estimate Source.”

“Activity Category” describes the type of research activity for which you’re providing estimates. In the sample budget, I’ve grouped all of the research activities chronologically. So, for example, in the “background interviews” category, I have line items for the cost of my travel from the US to Ghana (line 7), the cost of printing interview consent forms (line 9), and the cost of small gifts (pens and folders) to give to interview respondents (line 10). There’s also one estimate that isn’t related to cost, where I listed the number of people I believed I would have to interview (line 11). Then I started a separate “survey” category, which captured all the costs of the various stages of the survey – from training surveyors, to doing initial community entry visits to all the towns where I wanted to carry out the survey, to doing the survey itself.

I find that listing activities chronologically can be a good way of making sure that I don’t forget to include any relevant estimates. For example, if I tried to immediately separate the estimates into “personnel costs,” “equipment,” and “travel” (as many funders request that you do), I might remember to
include the tablets for the survey under “equipment,” but forget to include the cost of printing consent forms for my background interviews. By listing activities chronologically, I can think through all the steps required to complete an activity, and make sure that all relevant items are included. The next section of this manual discusses how to format a budget in the “personnel / equipment / travel” format that many funders require.

It’s worth noting here that the assumptions sheet isn’t just for estimates about cost! Any estimate that influences your total budget can be listed here. For example, as noted in the previous section, I needed to estimate how long it would take to survey 300 people in 30 towns. That’s 10 people per town. Let’s say one surveyor can speak to 3 people per day. If I had a team of four surveyors, they could speak to 4 * 3 = 12 people per day, which is more than enough people to finish interviewing everyone in one town in a day. That means that I would need 30 working days to finish the survey in 30 towns. This is a more accurate way of estimating the total time needed for the survey than just coming up with some blanket estimate like “I think it will take two weeks to talk to 300 people.” All of these estimates are in the “survey” subcategory which starts at line 34. This way, I’ve clearly documented how I came up with this time estimate, and could also easily adjust if I found that the survey was taking more or less time than I anticipated.

Beyond your research activities, remember to include financial variables such as exchange rates, inflation rates, and a contingency fund. The standard rate for contingencies is 10% of all costs.

The second column is “Unit Description.” Here, you can provide more information about each line item if it’s needed. “Value” is the value of the estimate. “Currency” only needs to be filled in if it’s a cost estimate. “Unit” describes the unit to which the value estimate applies – is this cost for buying one tablet, or 15 of them?

“Estimate Source” documents where you got the figure. It’s best to rely on sources that can be precisely documented when possible. For example, it’s better to get the cost of a flight directly from the airline, rather than trying to remember the cost the last time you took the flight. However, if you can’t find another good source, it’s fine to use your personal experience for some estimates. For example, in the sample budget, you can see that I listed “Work with IPA in 2010” as the source of many estimates. I managed a survey for the research group Innovations for Poverty Action in Ghana in 2010, and used my knowledge of their average surveyor salaries, etc. for my cost estimates.

3.3. Filling in the Budget

Once you have your timeline and assumptions finished, writing the budget is fairly straightforward. Again, the major principle here is to let Excel do the work for you. It’s possible to create the budget exclusively by linking cells back to the assumptions sheet, and using Excel’s built-in calculation tools to
do any required calculations for you. You shouldn’t have to type much, if any, data by hand in your budget.

The budget sheet in “Mawazo Sample Budget 2018” has eight columns: “Budget Category,” “Unit Description,” “Number of Units,” “Unit Cost,” “Currency,” “Total Cost (Original Currency),” “Total Cost (USD),” and “Notes.” “Budget Category” in the budget sheet is closely related to the “Activity Category” column in the assumptions sheet. However, I’ve made one big change here. While the assumptions sheet was organized chronologically, I’ve organized the budget in the “Personnel / Equipment / Travel” format that funders often request. This means that line items for the same activity (like salaries for surveyors, and tablets to administer the surveys) will often go into different categories in the budget (like “personnel” and “equipment”).

Here’s how I handled this.

• I created the three overall categories of “personnel,” “equipment,” and “travel” first
• Within each category, I created subcategories in the chronological order of my research. So, for example, the “personnel” category has subcategories for “hiring and training surveyors,” “community entry” and “survey”
• I went through the assumptions sheet again, and made sure that all the personnel costs for each of those activities were listed in the budget
• Once I had listed a cost in the budget, I highlighted the related cell in orange in the assumptions sheet, to document that I had already included it
• I then repeated the process for the “equipment” and “travel” categories

Here’s an example. Figure 6 shows the list of assumptions related to hiring and training surveyors. As you can see, this includes equipment costs (venue rental and printing) as well as personnel costs (per diems and catering). It also has some assumptions that are about time or staff numbers, rather than cost (like the number of training days and total number of staff trained).

Fig. 6: Assumptions about Hiring and Training Surveyors
Look at the figure below, which is a repeat of Figure 1. This is how I moved the hiring and training activities from the assumptions sheet into the “personnel” category of the budget sheet.

- I created the “hiring and training” subcategory, which helps me keep my line items organized
- I identified the two activities that fit the “personnel” category and created a line item for each of them. As a shortcut, you can link the relevant cell in the “budget category” column to the cell in the “activity category” column under assumptions. (Here, link A9 in budget to A24 in assumptions – the cell about “per diems for training attendees”. This works for text as well as numbers!)
- I linked the “unit cost” cell for each line item in the budget to the relevant “value” cell in the assumptions sheet
- I calculated the “number” of units” for each line item. For example, the figure of 300 per diems came from the assumption of 25 surveyors trained per region (line 23 in assumptions) * 3 days of training time for each region (line 21 in assumptions) * 4 regions (line 37 in assumptions)
- Finally, once I had finished including the “per diems” line item in the budget, I highlighted the per diems line item in the assumptions sheet in orange to show that I had put it into the budget already.

Fig. 1 (again): Budgeting for Personnel

As you can see, both the “number of units” and the “unit cost” figures were taken directly from the assumptions sheet. I didn’t have to put any of those figures in by hand.

Even if you’re only using one currency in your research, you should still make sure that each expense has its currency labelled in the “currency” column.
It’s easy to do this by linking the “currency” cell for each line item in the budget back to the same line item in the assumptions sheet.

Calculate the “total cost (original currency)” by multiplying the number of units by the unit cost. But don’t do this by hand! Let Excel do it for you. That’s why the “total cost (original currency)” cell is highlighted in blue, to indicate that this was a cell whose value was produced by a calculation in Excel.

For this budget, I also converted all of the costs from their original currency to US dollars in the “total cost (USD)” column. I did this by dividing “total cost (original currency)” by the current exchange rate, which is listed on the assumptions sheet. Again, this calculation was done by Excel, and it’s highlighted in blue for that reason. If you’re only using one currency, you can delete the “total cost (USD)” column.

Finally, the “notes” column actually has a very important role to play! It’s where you can provide any further explanations about your costs, as needed, and document any calculations you made in the spreadsheet that weren’t obvious. For example, in line 9, I explained how I decided that I would need 300 per diems (25 surveyor trainees per region * 4 regions * 3 days of training). Even if a figure seems really obvious to you right now, it’s always best to explain how you arrived at it. If you have to look at the budget again in a few months, or want to use it as a template for another project in a year, you’ll probably have forgotten where that figure came from, and may have to redo all your calculations to make sure they’re correct. Again, providing more detail is always better than providing less.

### 3.4. Writing the Budget Narrative

The budget narrative brings together all the work you’ve done so far on the timeline, assumptions, and budget. The goal of this is to take all the figures in Excel and **discuss how you came up with your estimates in a straightforward manner**. It’s the final step in fulfilling the core budgeting principles of documenting your assumptions and calculations, and providing sufficient detail about your work.

Beyond serving as a useful description of your work, writing the budget narrative is helpful because it forces you to check over your budget again. I found and corrected several errors in the sample budget as I was writing the narrative for it (the “Mawazo Sample Budget Narrative 2018”).

---

**Fig. 7: The Notes Column**

<table>
<thead>
<tr>
<th>Budget Category</th>
<th>Number of Units</th>
<th>Unit Cost</th>
<th>Total Cost (Original Currency)</th>
<th>Total Cost (USD)</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Personnel</td>
<td></td>
<td></td>
<td></td>
<td>30850</td>
<td></td>
</tr>
<tr>
<td>Hiring + Training</td>
<td>Per diems for training</td>
<td></td>
<td></td>
<td>4950</td>
<td></td>
</tr>
<tr>
<td>9 attendees</td>
<td>300</td>
<td>50 GHC</td>
<td>15000</td>
<td>3750</td>
<td>25 attendees per region * 4 regions * 3 days of training</td>
</tr>
<tr>
<td>10 Catering for lunch</td>
<td>12</td>
<td>400 GHC</td>
<td>4800</td>
<td>1200</td>
<td>GHC 400 * 4 regions * 3 days of training</td>
</tr>
</tbody>
</table>
Start the budget narrative with a **summary of your research question**, and the research methods you will use to answer it. This will provide useful context for the reader about the expenses you are going to discuss. Include a **brief project timeline** in the summary. Don’t forget to mention the **total cost** of the project in the summary as well.

Next, go through the budget in order, and **describe the costs for each section**. Since I did my budget in the “personnel / equipment / travel” format, I have three sections in the budget narrative. In each one, I’ve written a detailed description of how I came up with the costs in the budget. It explains in clear language which assumptions I made, and how I used those assumptions to calculate the total cost for each line item.

### 4. Financial Management

Building a budget is only one part of the broader practice of financial management. More broadly, good financial management entails planning ahead for expenses; keeping track of expenses as they’re incurred; and comparing your expenses to your budgeted costs, to make sure you’re not going over budget. In this section, I’ll use the “expense tracking” sheet in “Mawazo Sample Budget 2018” to demonstrate how to track expenses and compare them to the budget.

#### 4.1. Planning Ahead for Expenses

One of the most obvious ways to plan ahead for project expenses is to create a budget, which at this point you’ve already done! Here are some other tips for managing expenses well.

- **Use your network** to learn about cost estimates and recommended vendors. Reach out to other PhD students and academics as you’re writing your budget to make sure that your cost estimates seem accurate, and see if they have recommended suppliers for things you might need to buy. You may even find that you can borrow some materials from other people instead of buying them, reducing your research costs.

- **Go comparison-shopping** for large items. If you have items in your budget which are relatively expensive, like equipment or flights, get quotes from 2 – 3 different vendors before you choose one.

- **Get invoices or contracts** from vendors when you’re offered a good price. If you’re satisfied with a quote, make sure you get it in writing, so the vendor can’t change the price later.

#### 4.2. Tracking Expenses

Tracking expenses is important because it helps you to be aware of the amount of research money that you have remaining – and whether you’re on budget or spending too much. The most essential thing to remember here is that **your expense tracking spreadsheet is only as good as the data you put**
If you’re not keeping track of your expenses on a regular basis, then you won’t have an accurate sense of how much you’re spending.

I’ll walk through the principles of expense tracking using the tracking sheet in the “Mawazo Sample Budget 2018” Excel document. This sheet has twelve columns: “Expense Category,” “Unit Description,” “Number of Units,” “Unit Expense,” “Currency,” “Date of Expense,” “Have Receipt,” “Total Cost (Original Currency),” “Total Cost (USD),” “Budgeted Cost,” “Money Remaining,” and “Notes.”

“Expense Category” should have all the same categories and sub-categories as the budget. The goal here is to list your expenses in a way that you can total them up and compare them to the projected costs in the budget, so it’s helpful to have it organized with the same categories that you had in the budget. (Remember, you can just link cells between the budget and expense tracking sheets, so you don’t have to re-type the names of all the categories.)

Under each expense category, you should create a new line item for each purchase that you make. This means that you’re probably going to have more lines in the expense tracking sheet than show up in the budget. For example, you might have budgeted for three bus trips to your research site (one-line item), but every bus ticket would be purchased separately on a different date, thus creating three line items in the tracking sheet. You can add as many additional lines as you need within each subcategory on the expense tracking sheet. In order to insert lines, click the row above which you’d like to insert more lines, then go to Insert > Rows in the ribbon at the top of the screen.

You should provide specific details about the expense in “Unit Description.” Fill in the values of “Number of Units” and “Unit Expense” by hand. Note that this is not the same as “Unit Cost” in the budget sheet. The budget contains the estimated cost of the item and the estimated number of items, whereas the tracking sheet contains the actual cost of the item and the actual number you purchased. If you recall from Section 2.3, I use green highlighting to show where I’ve manually entered a figure in the budget. In Figure 8, you’ll see that “number of units” and “unit expense” are both highlighted green.

Fig. 8: Tracking Expenses

<table>
<thead>
<tr>
<th>Expense Category</th>
<th>Number of Units</th>
<th>Unit Expense</th>
<th>Currency</th>
<th>Date of Expense</th>
<th>Have Receipt?</th>
<th>Total Expense (Original Currency)</th>
<th>Total Expense (USD)</th>
<th>Budgeted Cost</th>
<th>Money Remaining</th>
</tr>
</thead>
<tbody>
<tr>
<td>20 Equipment</td>
<td>40</td>
<td>$200</td>
<td>USD</td>
<td>27-May-16</td>
<td>Yes</td>
<td>80</td>
<td>820</td>
<td>210</td>
<td>-10</td>
</tr>
<tr>
<td>21 Background Interviews</td>
<td>40</td>
<td>$200</td>
<td>USD</td>
<td>27-May-16</td>
<td>Yes</td>
<td>80</td>
<td>820</td>
<td>210</td>
<td>-10</td>
</tr>
<tr>
<td>22 Interviewee gifts</td>
<td>40</td>
<td>$200</td>
<td>USD</td>
<td>27-May-16</td>
<td>Yes</td>
<td>80</td>
<td>820</td>
<td>210</td>
<td>-10</td>
</tr>
<tr>
<td>23 Interviewee gifts</td>
<td>40</td>
<td>$200</td>
<td>USD</td>
<td>27-May-16</td>
<td>Yes</td>
<td>80</td>
<td>820</td>
<td>210</td>
<td>-10</td>
</tr>
<tr>
<td>24 Printing</td>
<td>40</td>
<td>$200</td>
<td>USD</td>
<td>27-May-16</td>
<td>Yes</td>
<td>80</td>
<td>820</td>
<td>210</td>
<td>-10</td>
</tr>
</tbody>
</table>

The “Date of Expense” and “Have Receipt” columns have been added to help you keep track of when you made each purchase, and to remind you...
to hold on to your receipts. You should scan or take photos of all your receipts, and save them to your laptop. It’s easiest if you label each scanned receipt by date so that you can easily sort through them later if needed.

“Total Expense (Original Currency)” and “Total Expense (USD)” are calculated by multiplying the number of units with the unit expense. (Again, Excel can do this for you, which is why these cells are highlighted in blue.)

Every time you add a new expense under a subcategory, you should redo the SUM command in the “Total Expense” column for that subcategory to make sure the new line is included. That way, you can accurately see how much you’ve spent in that subcategory. If you’ve used Excel to add up all the subcategory totals to find the category total, then that latter figure will also be automatically updated.

The biggest problem people face with expense tracking is waiting till the last minute to do it. You’ll save yourself a lot of hassle in the long run if you commit to adding each expense to the tracking spreadsheet on the same day you make the purchase. Take 15 minutes at the end of every day to take a photo of your receipts, create new line items for each expense, and update the subcategory total to include the new expenses. Don’t forget to update the “date” cell at the top left of the sheet as well, in order to clearly document when you last included new expenses.

As a matter of Mawazo policy, if an activity is listed in your budget, then you need to get a receipt for that purchase, no matter how small. If you can’t provide a receipt for an item, you may be asked to return that amount of research funding. If we feel that this reflects a broader pattern of poor financial management, then we may withhold future stipend disbursements until we’ve worked together to improve your expense tracking.

4.3. Compare Your Expenses to Your Budget

Now that you’ve got an accurate estimate of how much you’re spending, it’s time to compare your expenses to what you budgeted for each research activity. It’s easy to do this when the expense tracking sheet is in the same Excel spreadsheet as the budget sheet.

Here’s figure 8 again. Look at the final two columns: “Budgeted Cost” and “Money Remaining.” In the “Budgeted Cost” column, you can link the cells for each category / subcategory back to the same category / subcategory in the budget. This lets you see the total budgeted amount for each category.

“Money Remaining” is calculated by subtracting your total expenses from the budgeted cost. You can do this for the overall category, and also for the subcategory.

Fig. 8 (again): Comparing Expenses to the Budget
Here’s how I did this for the Equipment category.

- Select the cell where you want the amount of money remaining to be displayed. In this case, cell K20 shows the total money remaining for the equipment category (it says 8530 in the image above).
- Type =
- Select the cell with the total budgeted cost for that category (J20, which says 8820). Now cell K20 displays =J20
- Type –
- Select the cell with the total expense for that category (I20, which says 290). Now cell K20 displays =J20-I20
- Hit the Enter key
- Now cell K20 will display the total amount of money remaining in that category ($8530), which is the budgeted amount ($8820) minus what you’ve spent ($290)

You can do the same thing for each subcategory as well. In the image above, you’ll notice that I budgeted $210 for purchases related to my background interviews, and actually spent $290. Now I’m aware that I’m already a little over budget, and may have to dip into my contingency fund or find ways to reduce other costs in the future.

At the upper left side of the expenses sheet, I’ve included one cell which lists the total budgeted cost, one which lists the total expenses to date, and one which lists the amount of money remaining. This expenses figure adds up the expenses across all the categories in the budget, and gives a comprehensive view of how much money you’ve got left.

Originally created by Rachel Strohm, Mawazo Institute. Licensed under a Creative Commons Attribution-ShareAlike 4.0 International license (CC-BY-SA).